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Chapter 1 Usage Overview 
The VDP (variable data print) module in ElecRoc is designed to output 

various types of files such as .txt, .csv and .excel that contain variable data, 
as an .inx file, in the layout or format that the data will be printed. The INX 
file can then be submitted to ElecRoc for digital / inkjet printing.  

The process is mainly comprised of the following steps:  

1. Enter into VDP module. In ElecRoc’s job window, you can click the 
rightmost toolbar icon  to enter into the VDP module. As shown in the 
below, its main body is an INX file list, while three icons located at the 
upper-right corner ( / / ) represent its three key tools.  

 
Figure 1  ElecRoc’s job window 

2. Data conversion. Click the icon  to run the data convert tool, 
converting one or more .txt (or .csv/.excel) files that contain variable data 
into an .epd data file, an intermediary format employed in the VDP module. 
The EPD file is the basis for the next step “template creation”. For details 
on data conversion, refer to Chapter 2.  

3. Template creation. Click the icon  to run the VDP Editor, 
defining via a template the layout or format the variable data will be 
printed. For details about the Editor, refer to Chapter 3.  
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4. INX generation. After you have got the EPD data file and the 
template, you can generate the INX file. Click the icon  to generate the 
INX file. For details about the generation, refer to Chapter 4.  

5. INX output. INX files’ output and related operations can be done 
with the toolbar icons located at the upper-left corner, or with the 
right-click menu items. See the following figure.  

 
Figure 2  VDP user interface 

1) Preview. Before real print, a preview aiming to check out the 
output result and thus avoid any possible print error is recommended. 
Choose an INX file and then click the toolbar icon ，or right-click the INX 
and then choose Preview, to open the following dialog box. Specify the page 
range and then click OK. The file for preview is in PDF format, and in 
general, the system will automatically start your Adobe Reader to open it.  

 
Figure 3  Preview INX 

2) Submit. After you have generated an INX file, click the refresh icon
 to show up it. And then you can submit for output (being printed or 

exported), in three ways.  

Way ①: Drag and drop the INX file onto the node in your job. This way 
supports 3 types of nodes, inkjet printer, digital printer, and PDF Export.  

Way ②: Choose the INX file and make use of the toolbar icons. A click 
on the icon  will list all the inkjet or digital printing nodes in your job for 
selection. And a click on the icon  lists all the PDF Export nodes.  
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Way ③: Right-click the INX file. The short-cut menu contains a 
command Submit to Output Processors, with which you can open the following 
dialog box.  

 
Figure 4  Submit INX 

Choose a node from the dropdown list, which contains all the inkjet & 
digital printing nodes from your job. The number in brackets indicates the 
node ID, which identifies the node in case that there are same node names 
in your job. In addition, you can specify the output range.  

3) Import/Export. The system supports you to import or export an 
INX file into or out of the INX file list.  

Click the icon  to import an INX file. This brings convenience for 
repetitive use of an INX file, e.g. in some cases an existing INX file can 
save you a lot of time needed to run the data convert tool, the Editor and 
the Generator over again.  

Click the icon  to export an INX file. Also this can be done by 
dragging and dropping the INX file to a PDF Export node in your job. Being 
exported from ElecRoc to any specified location, the INX file can be easily 
backed up or saved for repetitive use.  

4) Delete/Empty.  

An INX file can be deleted from ElecRoc by clicking the toolbar icon  
or by right-clicking the INX file and choosing Delete.  

All the INX files in current job can be deleted from ElecRoc by clicking 
the toolbar icon  or by right-clicking any file and choosing Empty.  
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Chapter 2 Data Convert Tool 
This tool is designed to help the VDP module, especially the Editor, 

identify the data contained in your clients’ various types of data files. The 
original data files from your clients may be .txt or .csv files, or Excel 
workbooks, or even SQL Server and Access database files. With this tool, 
all of these file types will be converted into an intermediary file format that 
can be identified by the system, i.e. .epd.  

Enabling the VDP module to correctly identify the data inside your 
clients’ files, the data conversion will not damage or lose any original data.  

In this tool, original data is classified into 3 types: Single, Composite, and 
Database. Sections 2.1-2.3 below are steps for converting the Single and 
Composite data, while Section 2.4 is for the Database.  

2.1 Single Data File 
1) Launch the Tool 

Click the rightmost toolbar icon  in ElecRoc’s job window to enter 
into the VDP module. And then click the icon  to run the convert tool.  

 
Figure 5  Launch the data convert tool 

2) Choose Original Data 
1) Choose a data type, here we take the simplest type Single Data as 

example (it is checked by default), see ①.  

2) Click the button Select File, see ②, and then choose from your local 
computer or network the original data file. Also this can be done by 
specifying a full file path.  
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Figure 6  Choose original data file 

Note: The example here is a CSV file named sample1.txt that can be opened with 
Windows Notepad. As shown in the below, it contains many lines of data, and each 
line consists of 6 pieces of data, separated by comma. Data in real production is 
perhaps simpler than this example, for instance, it might contain only barcode 
number.  

 
Figure 7  Example file 

Click Confirm to enter into the following window.  

1 

2 
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Figure 8  Initial result 

3) Configure parameters 
Configure the following parameters at the lower-right corner (see ③):  

Text Encoding: specify the encoding mode used by the original file, e.g. 
ANSI, so that all characters in the file can be identified.  

Field Separators: specify or input the separator used between any two 
data segments each line in the original file, e.g. comma.  

DataFilter: The first line in the original file is often the names for the 
variables (or fields), and thus cannot be regarded as data and should be 
filtered. Click the button  aside the DataFilter parameter to open a dialog 
box, see ④, and then choose First Line Data and click Add, and then click 
OK.  

Click Yes in case that you see the following pop-up when you are 
configuring the above parameters.  

 
Figure 9  Pop-up 

As displayed in the Structure area (located at the upper-right corner), 

3 4 
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the first line has been identified as field names, see ⑤.   

4) Save the Settings 
Click the toolbar icon ，see ⑥, to save the above settings.  

 
Figure 10  Save the settings 

5) Data Preview 
Click the toolbar icon , and input the data range you want to preview, 

see ⑦, and then click Confirm. The result shows what fields are contained 
in each line of data, and what detailed value is for each filed.  

 
Figure 11  Data preview 

7 

5 
6 
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6) Submit for Conversion 
Return to the main window and click the toolbar icon . If converted 

successfully, a hint pops up. In case that you want to stop the conversion 
halfway, you can click the toolbar icon .  

 
Figure 12  Data Conversion 

Now you have completed the conversion. And you can exit the tool.  

Note: Operations are different if you chose an original data file of fixed length.  

1) In this case, choose Fixed Length for the Field Separators parameter.  

 
Figure 13  Choose original data file 

2) In the next window, choose the Structure node at the upper-right corner, see ①, 
and then at the left area, press down and drag the left mouse button to choose a data 
of certain length, and then release the mouse button. Input field name in the pop-up 
dialog and then click OK, see ②. In this way, you have defined a field and set its 
values.  
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Figure 14  Field divide 

Repeat the above operation to divide the rest data into multiple fields.  

 

2.2 Composite Data File – CSV 
1) Choose Original Data 

After you enter into the tool, choose Composite Data, and then choose a 
CSV file by using the button Select File, and then click Confirm.  

 
Figure 15  Choose original data file 

Note: This dialog box can be opened anytime by clicking the toolbar icon , or 
by choosing from the main menu File > New Data Mode.  

The example used here is named sample1.csv, which can be opened by 
Notepad or Excel. As shown in the below, it contains many lines, and each 

1 

2 
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line consists of 6 pieces of data, separated each other by a comma. The 
first line is names, and the rest lines are data and different from each other. 
Data in real production perhaps is simpler than this example, for instance, 
it might contain only barcode number.  

 
Figure 16  Example file 

2) Wizard’s step 1: Frame Analyze 
A wizard window appears after you click Confirm in the previous step. 

The first step of the wizard is named Frame Analyze.  

 
Figure 17  Frame Analyze 

1) On the directory tree in the middle of the window, ensure that the 
original file File1 is being selected, see①.  

2) Configure parameters at the lower-right corner as follows, see②:  

Set Field Separators to a comma (this is because each piece of data in 
the example original file is separated by a comma).  

Set Recording Parse Mode to Fixed row (this is because each line in the 
example original file is different from each other). A hint pops up. Click Yes.  

1 

2 
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Figure 18  Hint 

Filter out the first line at the DataFilter parameter. As to the example 
used here, its first line is names, and should not be regarded as data, and 
thus need to be filtered. Click the DataFilter parameter to open a dialog box, 
choose First Line Data from the dropdown list, and then click Add and OK.  

 
Figure 19  Filter the first line 

3) Click Next.  
 

3) Wizard’s step 2: Field Divide 
The second step of the wizard is Field Divide.  
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Figure 20  Field divide 

First, check if the type and name for each field are correct. The type is 
Character by default. If it is actually not Character, please set it to its real type. 
As to the name, once being filtered, the first line will automatically be 
regarded as field names, and in this case, you do not need to change them. 
In case that the first line is not filtered, the names by default will be Field1, 
Field2, and so on. For better memory, please re-name them at your will.  

1) In the middle of the window, see①, expand the Structure node (by 
clicking ) to show up all the fields (the example above contains 6 fields). 
And then choose a field.  

2) See②, to change the type, find out the Field type parameter at the 
lower-right corner and choose its right type. To change the name, find out 
the parameter Name and input a new name.  

Then, if needed, you can further divide a field (see steps 3)-6) below). 
CSV file often uses symbols such as comma to divide a line into several 
fields, and thus a further divide is usually not needed.  

3) If you need to divide a field, choose the field and then choose a 
suitable option at the Split type parameter, see③. Here we take the option 
CSV as example, and then choose a separator at Field Separators (input 
manually in case that your needed option is not in the list). The result will 
be immediately displayed in the left table.  

1 

2 
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Figure 21  Divide a field 

4) The icon  becomes activated when you have chosen a field divide 
mode. Click this icon or right-click a field and then choose Insert node, to 
open a dialog, see④. Input the node name and click OK.  

5) Repeat the step 4) to insert another node, i.e. by steps 4)-5) you 
will create two sub-fields under the field, see⑤.  

6) Choose the first sub-field and set its Field index to 1. And similarly, 
set that for the second sub-field to 2, see⑥.  

And then, click Next.  
 

4) Wizard’s step 3: Data Structure 
Expand all nodes to see if the data structure determined by previous 

two steps is correct or not. If correct, click Next to continue; if not, you can 
click Back to re-configure.  

3 

5 

6 
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Figure 22  Data structure 

 

5) Wizard’s step 4: File Combine 
The system asks if you want to add other data file, after you click Next 

in the previous step.  

 
Figure 23  Add File 

If needed, click Yes. If not, click No to continue the next step.  

If you choose Yes, you will then repeat the previous 4 steps, i.e. to 
choose a new data file, and then analyze, divide, and confirm structure, till 
you see the above pop-up over again. Then click No to see the following 
user interface.  
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Figure 24  File Combination 

Here we take the Keywords mode as example.  

1) Choose a file as main file, e.g. File1, and then choose a field from the 
main file as Main Key One.  

2) Choose a file as sub file, e.g. later-added File2, and then choose a 
field from the minor file as Sub Key One.  

To set up an effective file combination, the values for the two fields 
Main Key One and Sub Key One must be completely the same.  

3) Click Add.  

Click Next.  

 

6) Wizard’s step 5: Final Structure 
This step displays the final data structure, determined by the previous 

steps, for you to confirm.  

If correct, click the toolbar icon  to save the settings.  

2 

3 
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Figure 25  Final data structure 

 

7) Data Preview 
Click the toolbar icon  in the above window. And then, in the pop-up 

window, input the preview range, and click Confirm.  

The result appears in the below, showing what fields are contained in 
each line of data, and what detailed value for each field is.  

 
Figure 26  Data preview 
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8) File Conversion 
Return to the main window, and click the button Convert or the toolbar 

icon . In case that you want to stop the conversion halfway, you can click 
the toolbar icon .  

 
Figure 27  Data Conversion 

A box pops up showing if the converting is successful. Now you have 
completed the conversion and can exit the tool.  

 

2.3 Composite Data File – Fixed Length 
1) Choose Original Data 

After you enter into the tool, choose Composite Data, and then choose a 
file of fixed length by using the button Select File, and set the Field Separators 
to Fixed Length, then click Confirm.  
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Figure 28  Choose original data file 

Note: The example used here is named sample1.txt, which can be opened by 
Notepad. As shown in the below, it contains many lines, and each line’s length is fixed 
and absolutely the same, without any separator.  

 
Figure 29  Example file 

 

2) Wizard’s step 1: Frame Analyze 
A wizard window appears after you click Confirm in the previous step. 

The first step of the wizard is named Frame Analyze.  
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Figure 30  Frame Analyze 

1) On the directory tree in the middle window, ensure that the original 
file File1 is being selected, see①. 

2) Configure parameters at the lower-right corner as follows, see②:  

Set Data Parse Mode to Fixed row (this is because each line in the original 
file is different from each other).  

Configure the DataFilter parameter if needed (Because the example file 
used here is comprised entirely of data, and thus nothing needs to be 
filtered).  

3) At the bottom of the window, click the icon  to open a dialog box, 
see③. Choose the type Rows, input node name and then click OK.  

Click Next.  

 

3) Wizard’s step 2: Field Divide 
The second step of the wizard is Field Divide.  

1 

2 

3 
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Figure 31  Field Divide 

1) In the middle of the window, see①, choose the Rows node created in 
the step 1 Frame Analyze.  

2) At the upper-left of the window, press down and drag your left 
mouse button to choose a certain length of data as the values for a field, 
see②, and then release the mouse button to open a dialog box. Input the 
field name and click OK.  

Also this operation can be done as follows:  

3) Choose the Rows node created in the step 1 Frame Analyze, and then 
click the icon  at the bottom of the window to open a dialog box, see③. 
Choose the type Field, and then input field name and click OK.  

 
Figure 32  Insert field 

4) Choose the newly-created field node on the directory tree, and then 

1 

2 

3 
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in the left data area, press down and drag your left mouse button to 
choose a certain length of data as the values for the field, and then release 
the mouse button to open a hint box. And choose OK. Values for the field 
can also be specified by way of the parameters Field Offset and Field Length 
at the lower-right corner, see④. The former refers to at which digit each 
value starts and the later refers to how many digits each value contains.  

 
Figure 33  Specify the values 

Repeat any of the two ways above to divide the rest data into multiple 
fields.  

After the dividing, please set correct type for each field. And each 
divided field, if needed, can be further divided into several sub-fields (see 
step 2 in previous Section 2.2).  

Click Next.  

 

4) Wizard’s step 3: Data Structure 
Expand all nodes to see if the data structure determined by the 

previous two steps is correct. If correct, click Next to continue; if not, you 
can click Back to re-configure. 

4 
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Figure 34  Data structure 

 

5) Wizard’s step 4: File Combine 
The system asks if you want to add other data file, after you click Next 

in the previous step. 

 
Figure 35  Add File 

If needed, click Yes. If not, click No to continue the next step.  

If you choose Yes, you will then repeat the previous 4 steps, i.e. to 
choose a new data file, and then analyze, divide, and confirm structure, till 
you see the above pop-up over again. Then click No to see the following 
user interface.  
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Figure 36  File Combination 

Here we take the Keywords mode as example.  

1) Choose a file as main file, e.g. File1, and then choose a field from the 
main file as Main Key One.  

2) Choose a file as sub file, e.g. later-added File2, and then choose a 
field from the minor file as Sub Key One.  

To set up an effective file combination, the values for the two fields 
Main Key One and Sub Key One must be completely the same.  

3) Click Add.  

Click Next.  

 

6) Wizard’s step 5: Final Structure 
This step displays the final data structure, determined by the previous 

steps, for you to confirm.  

If correct, click the toolbar icon  to save the settings.  

2 

3 
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Figure 37  Final data structure 

 

7) Data Preview 
Click the toolbar icon  in the above window. And then, in the pop-up 

window, input the preview range, and click Confirm.  

The result appears in the below, showing what fields are contained in 
each line of data, and what detailed value for each field is.  

 
Figure 38  Data preview 
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8) File Conversion 
Return to the main window, and click the button Convert or the toolbar 

icon . In case that you want to stop the conversion halfway, you can click 
the toolbar icon .  

 
Figure 39  Data Conversion 

A box pops up showing if the converting is successful. Now you have 
completed the conversion and can exit the tool.  

2.4 Database File 
1) Choose Original Data 

After you enter into the tool, choose Database, and then you will see a 
dialog box popped up, see the left figure below.  

  
Figure 40  Database 

1) At the parameter Data Source, choose Excel (see①, here we take 

1 

2 
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Excel as example, if needed, you can choose other option).  

2) At the parameter File Name, see② above, input the full file path or 
click Browse to choose the Excel file.  

3) See③ above, Click the button Select to open the following dialog box, 
and in which you need to tick the sheets you want to use.  

 
Figure 41  Choose Data Sheets 

Note: The example used here is named Sample.xls, and can be opened with Excel. 
It contains three sheets. The two sheets ticked in the above figure contain the 
content as shown in the below.  

  
Figure 42  Example file 
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2) Wizard’s step 1: Frame Analyze 
A wizard window appears after you click Confirm in the previous step. 

The first step of the wizard is named Frame Analyze.  

 
Figure 43  Frame Analyze 

1) Choose a sheet from the directory tree located at the upper-right 
corner of the window, see①, by default, the last sheet will be selected. 

2) Click Next.  

 

3) Wizard’s step 2: Field Divide 
The second step of the wizard is Field Divide.  

1 

2 
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Figure 44  Field Divide 

1) The system automatically finishes the work of dividing fields. 
Expand the node Table Structure (see①, by clicking ) located in the middle 
of the window, and you can see the automatically-generated fields (in the 
example above, four fields are displayed). 

2) By default, the system names the fields with the content in the first 
row of the sheet. If needed, you can choose a field and then rename it at 
the lower-right corner of the window, see②. 

Click Next.  

 

4) Wizard’s step 3: Data Structure 
Expand all nodes to see if the data structure determined by the 

previous two steps is correct. 

1 

2 
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Figure 45  Data Structure 

If you have ticked more than one sheet, please choose other sheet 
located at the upper-right corner, and then repeat the previous three steps 
to determine its data structure.  

When you have determined all sheets’ data structures, click Next to 
continue; if not, you can click Back to re-configure. 

 

5) Wizard’s step 4: File Combine 
The system asks if you want to add other data file, after you click Next 

in the previous step. 

 
Figure 46  Add File 

If needed, click Yes. If not, click No to continue the next step.  

If you choose Yes, you will then repeat the previous 4 steps, i.e. to 
choose a new data file, and then analyze, divide, and confirm structure, till 
you see the above pop-up over again. Then click No to see the following 
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user interface.  

 
Figure 47  File Combination 

Here we take the Keywords mode as example.  

1) Choose a file as main file, e.g. Sheet1, and then choose a field from 
the main file as Main Key One.  

2) Choose a file as sub file, e.g. later-added Sheet2, and then choose a 
field from the minor file as Sub Key One.  

To set up an effective file combination, the values for the two fields 
Main Key One and Sub Key One must be completely the same.  

3) Click Add.  

Click Next. 

 

6) Wizard’s step 5: Final Structure 
This step displays the final data structure, determined by the previous 

steps, for you to confirm. 

If correct, click the toolbar icon  to save the settings.  

2 

3 

1 



Variable Data Print User Guide 

 

32 

 
Figure 48  Final data structure 

 

7) Data Preview 
Click the toolbar icon  in the above window. And then, in the pop-up 

window, input the preview range, and click Confirm.  

The result appears in the below, showing what fields are contained in 
each line of data, and what detailed value for each field is.  

 
Figure 49  Data preview 
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8) File Conversion 
Return to the main window, and click the button Convert or the toolbar 

icon . In case that you want to stop the conversion halfway, you can click 
the toolbar icon .  

 
Figure 50  Data Conversion 

A box pops up showing if the converting is successful. Now you have 
completed the conversion and can exit the tool.  
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Chapter 3 VDP Editor 
The Editor is used to design the layout or format by which the variable 

data is printed. Its outcome is a template file.  

Click the rightmost toolbar icon  in ElecRoc’s job window to enter 
into the VDP module. And then click the icon  to run the Editor.  

 
Figure 51  Main window 

3.1 Resource Management 
We recommend you first to upload into the system the pictures and 

PDF files you want to use.  

Choose from the main menu Resource > Resource Manager to open the 
upload window.  

We take the picture uploading as example. At the time when you print 
variable barcodes on a product’s package box, you may need to use the 
design picture of the package box as background, to play a reference role, 
so that you can better determine the barcode’s position.  
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Figure 52  Resource Management 

Choose the icon  at the upper-left corner, and then choose at the left 
pane the pictures you want to upload, from your local computer hard disk, 
and then click the button  to upload. Pictures shown at the right pane are 
uploaded ones available for use.  

Return to the main window, and now you can create your template.  

3.2 Create New Template 
Each time when you start up the Editor, a new template will be created 

automatically. By clicking the toolbar icon  or by choosing from the main 
menu File > New Template, you can manually create a new one.  

At the lower-left pane, choose Doc Layout and then configure the 
template’s properties by way of the parameters displayed at the rightmost 
pane. Mainly, please use Page Definition and Data Template to set the page 
size and the EPD data file.  

As to other parameters, define them according to your actual needs. 
For instance, the resolution is 600x600 dpi by default. If you want to use 
another resolution, before you create a new template, choose from the 
main menu Edit > Preferences, and then define it by way of the parameters 
Normal > Horizontal/Vertical Resolution. Its value range is 300-1200 dpi.  
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Figure 53  Template Properties 

Page Definition: The size and orientation for the finally-generated file. 
The default setting is A4 Portrait.  

Data Template: The EPD file generated by the data convert tool. By 
clicking the blank area behind this parameter, you will activate a button ; 
and by clicking this button, you will open a window, in which you can 
choose an EPD data file you want to use.  

Note: In case that you are using simple data, i.e. data with single structure or 
the Simple data supported by the data convert tool, you can directly use the Editor’s 
Data Binding instead of using the data convert tool to generate an EPD file.  

 
Figure 54  Data Binding 
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3.3 Add Items 
In the toolbar lists 8 types of items that can be added into a template. 

To add an item, drag and drop it to suitable position on the page. As 
example, here we add some commonly-used items, including image, 
graph, barcode and text.  

 
Figure 55  Add Items 

3.4 Configure Items 
Respectively choose the added items and configure their properties. 

This work can be done by using the parameters at the right pane, or 
right-click menu commands, or main menu commands.  

1) Size & Position 
There are three methods to adjust the size and position.  

 
Figure 56  Size & position 

1) Choose an item and use a drag & drop to randomly move it. And 

Drag and drop 
onto the page 

1 

2 
3 

Center an item 
on the page 
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being selected, each item shows 8 orientation points at its 4 sides and 4 
angles. Move the cursor onto such point, and then drag and drop, in this 
way you can freely change the item’s size.  

2) Use the parameters at the right pane, mainly the size and position 
parameters, see① above, to accurately define the size and position. The 
position parameter controls the coordinates of the item’s upper-left corner. 
The origin of the coordinate system is the upper-left page corner.  

3) Use the commands under the right-click menu Position or main 
menu Layout > Position, see② above, to snap an item to 4 page edges, or 
center it horizontally, vertically, or at both directions on the page.  

2) Image 
Image item is often used as a fixed background picture that plays a 

reference role, so that you can better determine where the variable data 
shall be output. Usually it uses the product package design picture, a 
picture that may have already been printed by offset press, and thus no 
need for being printed as variable data by digital or inkjet printers.  

Choose an image item, and then click at the blank area behind the 
Content parameter at the right pane, see③ above, and then choose New 
from the activated dropdown list.  

  
Figure 57  Specify the image 

Click the button  behind the parameter Image File, and then choose 
an image you want to use, from the pop-up dialog box. Optional images 
are those uploaded previously by using Resource Manager.  
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Figure 58  Setting finished 

You may further define related parameters, at the right pane, such as 
scaling and centering. In general, the default settings are recommended.  

Note: After you have configured the properties, we suggest you right-click the 
item and choose Lock, to lock its size, position, and other properties, so as to prevent 
any unintended modification in the next operations.  

3) Graphic 
Before you configure the barcode item, you may need a graph item to 

produce a white background, printed out with white ink and used as a 
bottom layer, underneath the barcode. This is applied to the case that no 
blank area on the background image is left for the barcode, or the case 
that the paper color is not white enough.  

1) Choose the item. First, you need to find out and choose the 
already-added graph item. At the lower-left corner of the window lists all 
the added items on the page, see① below.  
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Figure 59  Adjust position & size 

2) Layer. Due to overlap between items, the graph item may be 
covered entirely by the image item configured previously. In this case, use 
the commands under the main menu Layout > Layer, or equivalent 
right-click menu commands, to show up the graph.  

At the lower-left corner, the more the item stays near the bottom, the 
more the item appears at the forefront; vice versa.  

3) View. If the item is too small to be viewed, you can use the toolbar 
icon  or the commands under the main menu View to zoom in the view.  

4) Size & position. Adjust the size and position as you do with the 
image item.  

5) Graph’s properties. Click the button  behind the parameter Path, 
see② above, to open the setup window.  

Here we take how to define the fill color as example: Click on the blank 
area behind the Fill Color parameter, and then choose the button New, 
see③ below. In the pop-up dialog, choose Fill Color and then continue to 
choose New, see④ below. And then choose a color and click OK (see⑤ 
below, for instance the spot color Spot white, choose the Spot Color mode 
and click the button Select, and then choose the spot color in the pop-up 
dialog).  

 

 

1 2 
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Figure 60  Configure a graph’s properties 

Note: If you want to use spot color, please choose from main menu Edit > 
Preferences > Spot Color Manager to define spot colors beforehand.  

Use the same method to define the outline color. Or you can choose 
Empty, which means not to use any color at all.  

4) Barcode 
Now let’s configure the barcodes.  

1) Choose the barcode item and move it onto the graph item.  

 
Figure 61  Configure the barcode’s size & position 

2) Barcode type and parameters. Choose a suitable barcode type at 
the parameter Barcode Type, such as Code 128C, and then click Barcode 

3 

4 

5 
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Parameter to open its parameter setup window.  

  
Figure 62  Barcode parameters 

Configure at least the following parameters:  

Height, Width: Specify the barcode’s height and width by way of the 
parameters Height and Module Size. Their values should base on your actual 
needs, see⑥ above.   

Preview Data/Data: There are two types of data. Preview Data refers to 
the data used only for preview. The barcode shown at the top of the setup 
window uses the preview data. The real data used in actual print is defined 
by way of the parameter Data. Such data for a barcode may be fixed 
constant data, or variable data, or even combination of constant and 
variable data.  

Click the button  behind the parameter Data, see⑦ above, to open a 
dialog box. At the left lists all optional variables, including those fields 
generated by the data convert tool. Expand and find out the varialbe you 
want to use, and then double-click it. At the right displays the variable you 
have chosen, including the default constant “ABCDEFG123456” (delete it if 
not needed). Click OK.  

Text: This setting controls if the barcode’s data appears as text along 
with the barcode after the print. If you want to print such text, please 
specify suitable font and size for the text, see⑧ above, ensuring the text 
be completely displayed within the given height and width.  

3) Size & position. Return to the main window. Make adjustment if the 
barcode’s position or height changes due to the above settings.  

5) Text 
As to the text item, do the configurations as per the methods above.  

6 

7 

8 
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Figure 63  Configure the text item 

1) Choose the text item, adjust its size and position, and then click the 
Data parameter to open its setup window, see①. 

2) Expand all optional variables, including system variables, and 
double-click the one you want to use. And then choose the text you added 
or input, right-click and choose Text style or Paragraph style, and you can 
further define the font or paragraph properties, see②.  

3) Take the text style as example. You can configure the details such 
as font, size, and font style, see③. 

3.5 Preview 
Choose the main menu File > Preview, or click the toolbar icon .  

  
Figure 64  Preview setup 

By default, the setup dialog box shows the name, the bound data file 
and output range for the current template. If needed, you can modify all of 

1 

2 3 
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them. And then click OK to open the preview window.  

 
Figure 65  The preview window 

3.6 Save Template 
Click the toolbar icon  to save your template.  

 
Figure 66  Save the template 
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Chapter 4 VDP Generator 
You can now use the Generator to make the INX file after you have 

produced the data file with the data convert tool and the template with the 
Editor.  

Click the rightmost toolbar icon  in ElecRoc’s job window to enter 
into the VDP module. And then click the icon  to run the Generator.  

 

 
Figure 67  VDP Generator 

Choose the template file. Click the Browse button behind Layout File to 
open the following window. Here lists all the templates created with the 
Editor on current ElecRoc Client.  
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Figure 68  Choose the template 

Before the generation, we suggest you click the button Preview to 
foresee the output result, so as to avoid any possible error.  

 
Figure 69  Preview the template 

Close the preview window, and return to the template selection 
window, click OK to back away.  

Choose the data file. Click the Browse button behind Data File to open 
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the following window. Here lists all the data files generated with the data 
convert tool on current ElecRoc Client. In general, choose the same data 
file that your template uses.  

 
Figure 70  Choose data file 

Note: If your template has been applied with Data Binding instead of a data file, 
please choose Simple from the Select epd directory dropdown list, and then you can see 
and choose the bound data file.  

 
Figure 71  Bind data 
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1) Click OK, and return to the main window.  

 
Figure 72  Parameter setup 

2) Choose a repetition type. Choose No reuse, if not needed.  

RIP reuse: At the time when the system outputs the data line by line, it 
will compare the output results of the first and second lines. If there are 
invariable or same data objects between the two results, such as fixed 
images and constant texts, then being checked, this option enables the 
system to re-use the tiffs of the same and invariable data objects, i.e. no 
longer RIP again these objects when it outputs the rest lines of the data, so 
as to improve the RIP efficiency.  

Device reuse: This option requires device support from the backend 
digital or inkjet printers, and currently is only applied to the HP Indigo 
series. If checked, in the device’s RIP process, it will re-use the tiffs of the 
same and invariable data objects, so as to improve the RIP efficiency.  

3) Specify the output range. The default setting All means to output all 
the variable data in your data file. If needed, you can choose Range or 
Custom and let the system output only part of the data.  

4) Click Start.  
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Figure 73  Generating INX 

5) The progress bar shows the progress. The log info below shows the 
detailed processing information. When the generation is completed, return 
to ElecRoc job window and click the refresh icon , and then you can see 
the generated INX file.  

 
Figure 74  INX file list 
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